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Circuite Integrate Monolitice pentru Microunde 

Proiect 

Tema de proiectare 

Se proiectează circuite pasive realizate în tehnologia prezentată la curs (Plessey). Se foloseşte 

EmPro pentru simulare electromagnetică şi Advanced Design System pentru simulare de circuit. La 

sfârşitul semestrului se predă un material care să descrie componenta implementată, analiza de 

convergenţă, schema echivalentă şi detaliile tehnologice - nr. de straturi/model metal etc. - (format 

hard sau electronic pdf/doc) împreună cu fişierele care implementează proiectul în EmPro (cel mai 

precis proiect din analiza de convergenţă, proiect funcţional – directorul corespunzător sau arhiva 

*.zep a proiectului) şi Advanced Design System (proiect funcţional – directorul "*_wrk" 

corespunzător sau arhiva *.7zads a proiectului). 

Fiecare temă va conţine dimensiuni fizice pentru următoarele componente: 

 bobină spirală pătrată, celulă standard 

 condensator planar (sandwich) cu poliimidă (PI) 

 condensator planar (sandwich) cu nitrură de siliciu (Si) 

Fiecare student va alege din tema proprie o singură componentă pentru a o analiza, ţinând cont de 

nota maximă pentru fiecare componentă (tabelul următor). 

Nr. Tip componentă Nota maximă 

1 Bobină 9 

2 Condensator PI 6 

3 Condensator Si 7 

Tabel 1. Teme de proiectare 

Pentru compensarea notei maxime (eventual) mai mici de 10 se poate beneficia de unul din 

următoarele bonus-uri: 

Nr. Descriere Bonus Detalii 

1 Utilizare structură cu trei straturi (GaAs+PI+aer) 0 fig. 8 - 9 

2 Utilizare structură cu cinci straturi (GaAs+Si+PI+Si) +1 fig. 12 - 13 

3 Utilizare model 2D pentru metalizări (PEC, h=0) 0 fig. 8 - 9 

4 Utilizare model 3D pentru metalizări (Plessey, h=0.5/3μm) +1 fig. 12 - 13 

5 Utilizare materiale din bibliotecă (GaAs+ Si3N4+PI+Cu) 0 fig. 4 

6 Utilizare materiale Plessey (GaAs+ Si3N4+PI+M2+M3) +0.5 fig. 5 - 6 

7 Utilizare 1 metodă (FDTD sau FEM) 0  

8 Utilizare 2 metode (FDTD şi FEM) +0.5  

9 Studiu de convergenţă în EmPro (minim 3 puncte)  +0.5 fig. 43 

10 Studiu de convergenţă în ADS (minim 3 puncte) +0.5 fig. 43 

11 Implementare decapsulare în EmPro sau ADS +0.5 fig. 38 - 41 

12 Depăşire termen limită de predare proiect −1 13.01.2018 

Tabel 2. Punctaj suplimentar 
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Note:  

 Modele mai complicate presupun creşterea considerabilă a timpului de calcul şi a memoriei 

necesare. 

 Unele combinaţii temă/bonus nu sunt posibile. De exemplu: utilizare structură cu trei straturi 

(GaAs+PI+aer) se poate aplica doar pentru bobină şi condensator PI nu şi pentru condensator 

Si, sau utilizarea modelului 2D pentru metalizări (PEC) nu e compatibilă cu utilizarea 

materialelor Plessey (M2/M3) 

 Toate componentele implică utilizarea a două nivele de metalizare (M2 şi M3) dar în plus 

realizarea bobinei implică modelarea trecerilor (via-holes) 

 Obţinerea punctelor bonus pentru studiul de convergenţă în EmPro şi/sau ADS necesită 

descrierea procesului în documentul predat (fişierele proiect nu conţin toate informaţiile). 

Straturile de materiale implicate sunt reprezentate simplificat în figura 1, indicându-se de asemenea 

suprafeţele pe care se depun cele două niveluri de metalizare M2 şi M3 (nitrura de siliciu se depune 

deasupra acestor metalizări pentru a evita conexiuni electrice nedorite). În tabelul 3 sunt prezentate 

caracteristicile materialelor utilizate în tehnologia Plessey (r şi tan  sunt date la 5GHz). 

 
Fig. 1. Straturi dielectrice 

Nr. Material r tan  [S/m] Rsq[mΩ/sq] h[μm] 

0 Ground   3.3·10
7
  10 

1 GaAs 12.85 0.3·10
-3 

  200 

2 Si3N4 7.2 15·10
-3

   0.13 

3 PI 3.4 55·10
-3

   1.4 

4 M2   3.6·10
7
 55 0.5 

5 M3   3.3·10
7
 10 3 

6 Aer 1 0   2000 

Tabel 3. Caracteristici materiale utilizate în tehnologia Plessey 

La începutul utilizării EmPro este util să fie realizate câteva modificări pentru a uşura în continuare 

introducerea elementelor. În primul rând, în fereastra de creare a unui proiect nou se pot specifica 

limitele domeniului de frecvenţă în care se fac analizele. Banda de validitate a tehnologiei Plessey 

este 1÷20 GHz dar se recomandă să fie depăşită în ambele direcţii (la unele metode, de exemplu 

FDTD) rezultatele obţinute la capăt de bandă sunt mai puţin precise. De aceea e recomandabil ca 

"Minimum frequency" să fie de ordinul 0.5GHz sau mai mic iar "Maximum frequency" să fie de 

ordinul 25GHz sau mai mare. Modificarea limitelor de calcul poate fi făcută şi mai târziu din 

fereastra "Parameters" (accesibilă din butonul corespunzător din partea dreaptă a interfeţei). 

h GaAs 

h Si 

h PI 

h Si 

M2 

M3 
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Fig. 2. Frecvenţe de interes 

Ţinând cont că în tehnologia Plessey toate dimensiunile sunt nativ disponibile în µm se recomandă 

ca printre primele acţiuni în proiecte să fie schimbarea unităţilor de măsură utilizate pentru lungimi 

în micrometri pentru a evita conversii multiple în timpul desenării. 

 
Fig. 3. Unităţi de măsură 

Deoarece utilizarea materialelor proprii tehnologiei aduce puncte bonus, în figurile 4 şi 5 sunt 

prezentate cele două posibilităţi. La selecţia materialelor standard (Default material library) e 

necesar să fie adăugate materialele GaAs, Polyimide, (eventual) Silicon Nitride şi Cu sau PEC. 

 
Fig. 4. Utilizare material standard 

Definirea materialelor proprii tehnologiei este cel mai uşor de realizat prin utilizarea unui model 

echivalent pentru materialul definit (de ex. Cu pentru M2/M3 sau GaAs standard pentru GaAs/ 

Si3N4/PI). Pentru metale definirea este de tip "Normal" (cu εr = 1 şi introducerea conductivităţii σ) 

iar pentru materialele dielectrice este esenţial ca tipul să fie "Nondispersive" (proprietăţile cât mai 
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constante cu frecvenţa) şi definirea de tip "Loss tangent" cu specificarea tangentei unghiului de 

pierderi la 5GHz. 

 
Fig. 5. Definire materiale Plessey utilizând model 

Modelul utilizat în acest caz, intern, permite obţinerea unor valori tanδ şi εr aproximativ constante cu 

frecvenţa aşa cum se poate observa alegând: Click dreapta "pe material" > "Plot Broadband material 

properties" (Fig. 6). 

 
Fig. 6. Caracteristici materiale dielectrice 

Pentru descrierea metalizărilor există mai multe nivele de detalii introduse, care sunt recompensate 

prin bonus-uri diferite (tabelul 2). În primul rând modelul utilizat în EmPro poate fi: 

 Metal Ideal (2D, Sheet Body, PEC), pierderi nule, înălţime egală cu 0 

 Modelarea pierderilor şi a înălţimii liniei (3D, Box, Cu sau M2/M3),  

 
Fig. 7. Geometria reală în circuitul integrat 
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Pentru varianta mai rapidă (3 straturi: GaAs, Poliimidă, Aer) se introduc ca model paralelipiped 

(Box) straturile de dielectric conform valorilor din tabelul 3, după care se aloca materialele 

corespunzătoare (în funcţie de punctajul dorit, materialele din biblioteca standard - fig. 4, sau cele 

definite anterior - fig. 5,6). Se lasă un spaţiu suficient de mare în jurul componentei (egal cel puţin 

cu dimensiunea corespunzătoare a componentei) pentru a elimina influenţa pereţilor asupra 

rezultatelor. Urmează desenarea dreptunghiurilor (plane - Sheet Body) care realizează metalizările, 

inclusiv liniile de acces la armături/spire. 

 
Fig. 8. Structură cu 3 straturi, metal ideal 

 
Fig. 9. Structură cu 3 straturi, metal ideal (detaliu) 
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Pentru această modelare se poate folosi condiţia la limită pentru z=0 pentru a modela planul de masă 

(de tip PEC) caz în care spaţiul adăugat în partea de jos (Lower z) va fi egal cu 0 pentru a asigura 

faptul că planul de masă ajunge sub stratul de GaAs. 

Pentru modelul cu punctaj mai ridicat (5 straturi, modelare metalizări 3D), mai asemănător structurii 

reale din fig. 7, se utilizează doar modelul de paralelipiped (Box) pentru introducerea straturilor de 

dielectric şi pentru desenarea metalizărilor. Astfel vor apărea în ordine: 

 un strat cu înălţimea de 10µm cu materialul M3 (planul de masă), 

 un strat cu înălţimea 200µm (GaAs), 

 primul strat cu înălţimea 0.13µm (Si3N4 - 1), 

 un strat cu înălţimea 1.4µm (Poliimidă), 

 al doilea strat cu înălţimea 0.13µm (Si3N4 - 2), 

 ultimul strat, cu înălţimea 2000µm (Aer) 

Considerând în continuare cazul condensatorului planar cu poliimidă (PI) de latură a armăturii L, se 

desenează metalizările M2, M3 (ca paralelipipede de laturi L şi înălţimi de 0.5µm respectiv 3µm, 

plasate central: x şi y între −L/2 şi +L/2). Liniile de acces la armături sunt de lăţime 40µm şi 

lungime egală cu spaţiul lăsat până la marginea structurii (în principiu L). În acest moment există 

suprapunere între metalizarea M2 şi paralelipipedele SiN_1, PI şi între metalizarea M3 şi 

paralelipipedele SiN_2 şi Aer.  

Rămâne de modelat faptul că pasivizarea de Si3N4 înconjoară metalizarea (şi M2 şi M3 - fig. 5). Cea 

mai simplă metodă de desenare constă în a desena două paralelipipede "temporare" cu material 

Si3N4 care să înconjoare paralelipipedele metalizărilor, la o distanţă de 0.13µm de acestea pe 

direcţiile laterale şi în sus. De exemplu pentru armătura M2 se desenează un paralelipiped cu laturile 

L + 2*0.13µm = L + 0.26µm şi de înălţime 0.63µm = 0.5µm + 0.13µm la acelaşi nivel după direcţia 

z ca armatura M2. Similar pentru metalizarea M3 şi pentru liniile de acces (liniile trebuie acoperite 

doar pe 3 suprafeţe, deasupra şi lateral, nu la capetele dinspre armătură şi peretele structurii şi nici 

dedesubt). Se introduce în acest fel o suprapunere suplimentară, dar în momentul în care se va 

"introduce" metalizarea în noile corpuri create se obţine o formă foarte apropiată de fig. 7. 

    
Fig. 10. Obiecte (iniţial şi final, după combinare) 

Urmează un proces esenţial, combinarea diverselor obiecte care să ducă la obţinerea structurii dorite. 

Procesul combinării poate fi urmărit cel mai uşor în "Project Browser" (structura arborescentă din 
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partea stângă a interfeţei), secţiunea "Parts" urmărind cum dispar/apar obiectele individuale şi cum li 

se schimbă icoana asociată. 

 
Fig. 11. Operaţii cu obiecte 

Operaţiunile de combinare a obiectelor se realizează selectând obiectele dorite din Project > Parts 

urmat de Right Click > Boolean > Operaţia dorită. Ca alternativă, după selecţia obiectelor, fereastra 

de desenare "Geometry" are meniul "Boolean" care oferă acces la aceleaşi operaţii. La unele operaţii 

vom dori ca unul sau ambele din obiectele originale implicate să rămână în continuare în structură, 

caz în care vom selecta opţiunea "Keep Original" din dreptul obiectului respectiv. La unele operaţii 

(în special "Substract") ordinea obiectelor este importantă ca urmare se va apăsa butonul "Swap 

Order" pentru a obţine ordinea corectă. Ordinea în care se realizează combinarea este (trebuie să 

fie) următoarea: 

1. Unire ("Union") elemente de pasivizare Si3N4 de la nivelul M2, SiN_1 + M2Si + M2_LSi, 

fără "Keep original", se unesc toate obiectele de Si3N4 de la nivelul M2 într-un singur obiect 

2. Unire ("Union") elemente de pasivizare Si3N4 de la nivelul M3, SiN_2 + M3Si + M3_LSi, 

fără "Keep original" 

3. Unire ("Union") elemente metalice de la nivelul M2, M2 + M2_L, fără "Keep original", se 

unesc toate obiectele de metalice de la nivelul M2 într-un singur obiect 

4. Unire ("Union") elemente metalice de la nivelul M3, M3 + M3_L, fără "Keep original" 

5. Extragere ("Substract") element compus de pasivizare Si3N4 de la nivelul M3 din Aer, "Keep 

Original" selectat pentru SiN_2 (se realizează astfel o operaţie de "Introducere" SiN_2 în Aer 

cu decuparea acestuia nu doar o Extragere simplă), după operaţie rămâne obiectul Aer 

decupat pentru a face loc pentru SiN_2 dar şi obiectul SiN_2 care ocupă exact locul creat 

6. Extragere ("Substract") element compus de pasivizare Si3N4 de la nivelul M2 din poliimidă, 

"Keep Original" selectat pentru SiN_1, obiectul SiN_1 va ocupa spaţiul decupat din PI 

7. Extragere ("Substract") element compus de metalizare M3 din elementul compus de 

pasivizare Si3N4 de la nivelul M3, "Keep Original" selectat pentru M3, obiectul M3 va ocupa 

spaţiul decupat din SiN_2 

8. Extragere ("Substract") element compus de metalizare M2 din elementul compus de 

pasivizare Si3N4 de la nivelul M2, "Keep Original" selectat pentru M2, obiectul M2 va ocupa 

spaţiul decupat din SiN_1 
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Fig. 12. Verificare structură la capete (linie de acces M2 sau M3) 

Este recomandabil să se realizeze apoi verificarea corectitudinii operaţiilor efectuate prin observarea 

detaliilor fizice ale structurii. Este relativ uşor de investigat zona în care structura desenată atinge 

marginile domeniului, de exemplu capetele liniilor de acces de pe nivelele M2 şi M3 (fig. 12) prin 

deplasare, rotire şi apropiere/depărtare ("Pan"/"Orbit"/"Zoom" ). Pentru a observa detalii din 

interiorul structurii este necesară activarea facilităţii de secţionare ("Cutting Plane" ) urmat de 

deplasarea/rotirea planului de secţionare pe o poziţie convenabilă ("Edit Cutting Plane") - fig. 13. 

  
Fig. 13. Verificare structură în secţiune (armături M2 şi M3) 

Urmează (paşi descrişi în L2/2017 şi L3/2017) introducerea porturilor, alegerea metodei de simulare 

şi efectuarea efectivă a calculelor (FDTD şi/sau FEM + analiză de convergenţă!) 

Note 

 E obligatorie creşterea incrementală a complexităţii modelului ales (nr. de straturi, model 

metal, dimensiune celule, eroare necesară pentru convergenţă), deoarece modelarea 

"completă" depăşeşte cu mult resursele de timp şi RAM pe care le aveţi la dispoziţie 

 Modelarea componentei se face fără introducerea elementelor suplimentare inevitabile în 

practică, dar care sunt caracterizate de modele suplimentare: trecere M2/M3 pentru revenirea 

pe nivelul de metalizare M3, tranziţii de la linia standard de conexiune (12/40μm) la linia 

utilizată în circuit, etc. (fig. 14,15). 

 Dimensiunile celulelor standard sunt: 

o bobină: lăţimea traseelor 12μm, spaţiul între trasee 12μm, latura trecerilor 40μm, 

diametru trecere (via) M3-M2 circulară cu diametru 30μm, prima spiră din jurul 

trecerii are latura internă 76μm (fig. 15), linia de acces pe M3 are diverse orientări în 

funcţie de numărul de sferturi de spiră din temă. 
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o condensatoare: lăţimea liniilor de acces la armături (M2 şi M3) este de 40μm (fig. 14) 

 Modelarea se încheie prin obţinerea modelului de circuit pentru componentă. Această 

operaţiune se realizează de mai multe ori pe parcursul realizării proiectului. Analiza de 

convergenţă presupune urmărirea variaţiei unei mărimi numerice importante din structură, 

iar în cazul componentelor simulate această mărime va fi valoarea componentei (mărimea 

principală, fără componentele parazite, L sau C). Ca urmare vor exista două bucle de 

verificare a convergenţei: 

o o primă buclă care va verifica obţinerea unor simulări corecte, realizată în EmPro 

direct fără suport al unor programe externe, implementată intern în ambele module de 

simulare FEM/FDTD. 

o o a doua buclă care va verifica faptul că s-a realizat secţionarea suficient de precisă 

(în celule suficient de mici) a structurii pentru a obţine modelul de circuit corect 

(care necesită determinarea C/L echivalente) 

   
Fig. 14. Modelare condensator, plane de referinţă 

   
Fig. 15. Modelare bobină, plane de referinţă 
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Modelarea în simulatorul de circuit se realizează în ADS (Advanced Design System, versiunea 

2016/2017). În principiu paşii sunt: 

 modelarea schemei echivalente pentru componentă, prezentată în slide-urile de la curs 

împreună cu relaţiile necesare pentru a calcula valorile iniţiale ale elementelor 

 compararea rezultatului (parametri S) cu rezultatele obţinute în EmPro 

 variaţia valorilor elementelor din schema echivalentă în vederea suprapunerii în banda largă 

(1-20 GHz) a celor două rezultate 

o în cazul alegerii temei cu bobină există o rezonanţă a parametrului S21 la o frecvenţă 

în interiorul benzii tehnologiei (1-20 GHz). Suprapunerea modelelor se face numai 

până la 80-90% din această frecvenţă 

Programul de simulare utilizat în laborator este Advanced Design System produs de firma Keysight 

(companie separată din Hewlett Packard). Programul este instalat pe sistemul de operare Windows 7 

64bit. Dacă doriţi instalarea programului pe calculatorul personal, se urmează paşii descrişi în 

fișierul "Indicatii instalare ADS si EmPro" de pe rf-opto.etti.tuiasi.ro (adresa server-ului de licenţă 

se poate obţine prin email, versiunile active fiind 2016 sau 2017). Programul se porneşte utilizând 

butonul de Start din Windows alegând succesiunea de comenzi Start > Advanced Design System 

2016.01 > Advanced Design System 2016.01. 

   

Fereastra principala a programului - Advanced Design System (Main)  permite gestionarea 

proiectelor (creare, ștergere, arhivare – în scopul transportului unui proiect pe un alt calculator există 

implementată o metodă de arhivare format 7-zip, rezultând un fişier cu extensia "7zads" care va 

păstra structura internă de directoare a proiectului), accesul la fișierele individuale ale proiectului.  

 
Fig. 16. Fereastra principală ADS 

Fiecare proiect (workspace) va fi stocat/va consta într-un director propriu cu numele "nume ales" + 

"“_wrk", implicit creat în directorul de instalare "C:\users\default\" dar calea poate fi modificată (şi 

cea implicită, de instalare, şi individual la crearea unui proiect nou). Fiecare proiect poate fi 

secţionat după dorinţa în mai multe biblioteci (library: File > New > Library), măcar una, asociată 

proiectului, fiind creată iniţial la crearea directorului "..._wrk". O bibliotecă va consta din diferite 

scheme care împart aceeaşi tehnologie de execuţie, va reprezenta fizic un subdirector 
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"nume_bibliotecă" + "_lib" în directorul proiectului şi poate fi utilizată într-un alt proiect dacă este 

nevoie. O bibliotecă poate conţine mai multe celule (cells). O celulă este echivalentă cu o schemă, 

este creată ca un subdirector "nume_celulă" în directorul bibliotecii părinte şi poate conţine mai 

multe vizualizări (views) ale aceleiaşi scheme. Vizualizările tipice includ: Schemă (File > New > 

Schematic), Layout (File > New > Layout) and Simbol echivalent (File > New > Symbol).  

Pentru a asigura găsirea mai uşoară a fișierelor este recomandat să alegeţi comanda View > Startup 

Directory  pentru a ajunge în directorul implicit urmată de comanda File > New > Workspace 

 pentru a crea un nou proiect. Crearea unui proiect constă din mai mulţi paşi ca în figurile 

următoare. La primul pas se poate introduce direct numele dorit pentru proiect (în acest caz 

terminaţia "_wrk" implicită este adăugată automat, se poate forţa un nume de proiect fără "_wrk" dar 

nu este recomandat) şi se alege directorul în care sa va salva proiectul (în discul D:\CIMM dacă în 

C: nu aveţi drepturi de scriere). La prima creare de proiect puteţi apăsa "Finish" după prima 

fereastră. Mai târziu, veţi putea alege şi un nume pentru bibliotecă, şi o anume tehnologie dacă este 

nevoie. 

Noul proiect şi biblioteca implicită asociată sunt deschise automat. Se creează o primă schemă 

utilizând butonul  din bară sau comenzile File > New > Schematic din meniu. Alegeţi un nume 

pentru celulă (vizualizarea implicită este Schematic). Salvaţi  schema. Dacă o veţi închide din 

greşeală, o puteţi deschide din fereastra principală, tab-ul "Folder View" sau "Library View". 

   

  
Fig. 17. Creare proiect nou în ADS 
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Fig. 18. Project Browser şi scheme în ADS 

Spre deosebire de EmPro, ADS este un program multi-fereastră, cu programe individuale care 

comunică între ele, astfel că vă puteţi găsi frecvent în situaţia în care aveţi 4 ferestre deschise 

simultan (fereastra principală - fig. 16, una sau mai multe scheme - fig. 18, simulatorul - fig. 24, 

programul de vizualizare a rezultatelor - fig. 25). 

ADS are componentele grupate pe palete poziţionate în partea stângă a interfeţei, gruparea fiind în 

funcţie de tipul componentei respective. Pentru introducerea schemei din această lucrare se vor 

folosi paletele (fig. 19): 

    
 

 
Fig. 19. Palete utilizate în realizarea schemei  

 Lumped Components - Elemente concentrate (RLC) 

 Simulation S_Param - elementele de control al analizei, parametri S în acest caz, deoarece 

analiza electromagnetică cu care se compară schema oferă numai aceşti parametri 

 Data Items - pentru introducerea rezultatelor analizei electromagnetice, un diport caracterizat 

prin fişierul cu parametri S obţinut în EmPro (eventual) 
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 Optim/Stat/Yield/DOE pentru implementarea algoritmilor de variaţie a elementelor din 

schemă 

Elementele comune, des întâlnite pot fi accesate din bara de butoane a programului de desenare a 

schemei (masa, fire, variabile, etc.) 

Pentru introducerea rezultatelor simulărilor din EmPro există două posibilităţi. O primă variantă 

constă în salvarea din EmPro a parametrilor S rezultaţi ca fişier Touchstone. Pentru aceasta se 

afişează în EmPro fereastra "Results", în lista "Simulation" simularea care se doreşte a fi exportată, 

în lista "Sensor" > "Circuit Results", în lista "Domain" > "All" sau "Frequency", în lista "Result 

Type" > "S-Parameters & Derived Results". În funcţie de tipul de simulator apare în lista din partea 

de jos un rezultat "S-Parameters" pe care prin Right-Click se poate alege "Export > Export to 

Touchstone File". Deoarece componentele simulate au un comportament logaritmic în frecvenţă 

(Z = j×ω×L sau Z =  1/j/ω/C) e recomandabil să fie ales la export "Sampling Type" de tip logaritmic. 

În acest caz introducerea simulării în ADS se foloseşte paleta "Data Items", componenta 

corespunzătoare multiportului care permite deschiderea unui fişier extern în format Touchstone. Prin 

activarea ferestrei de proprietăţi a multiportului (Dublu-Click) se poate seta numărul de porturi (2 în 

acest caz) operaţiune care determină schimbarea simbolului din schemă astfel încât să corespundă 

numărului de porturi ales. Butonul Check/View S-Parameters porneşte un instrument ajutător care 

permite inspectarea rapidă a fişierului cu parametri S încărcat (Browse). 

 

Fig. 20. Export fişier cu parametri S în EmPro 
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Fig. 21. Utilizare fişier cu parametri S în ADS 

 

 
Fig. 22. Export (EmPro) şi utilizare (ADS) a rezultatelor emModel 

O a doua variantă constă în utilizarea comunicării native între cele două programe (create de acelaşi 

producător - Keysight) prin selectarea din meniul EmPro File > Export > Simulation Results as 

emModel. Se alege simularea dorită din listă şi un nume (eventual schimbat la o denumire mai 

sugestivă), realizându-se în acest mod salvarea datelor ca bibliotecă standard ADS. În fereastra 

principală din ADS unde este deschis proiectul se alege din meniu File > Manage Libraries > Add 

Library (Yes). Se verifică selecţia corectă prin faptul că după alegerea directorului corespunzător în 

zona "Name" apare denumirea acelui director (ADS detectează că acel director conţine o bibliotecă 
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standard). În caz de succes va apărea o celulă cu numele ales în EmPro la export (de exemplu 

"fem_rslt" în figura 22). 

Se introduce schema (din fig. 23) prezentată la curs, valorile iniţiale fiind obţinute cu ajutorul 

relaţiilor de la curs (schema şi valorile sunt diferite în funcție de tema aleasă). Modelul emModel se 

introduce prin Drag'n'Drop pe schemă de la celula corespunzătoare modelului importat (fem_rslt în 

exemplu), vizualizarea "Symbol". 

 
Fig. 23. Verificarea schemei echivalente pentru comparaţia cu rezultatul analizei electromagnetice  

Nota1: Are importanţă poziţionarea corectă a porturilor astfel încât să corespundă cu notaţia 

porturilor în EmPro, mai ales la schemele asimetrice (bobină şi condensator PI). De exemplu în 

EmPro portul 1 este pe nivelul de metalizare M3 iar portul 2 este pe nivelul M2 ca urmare în figura 

23 în ADS portul 1 (elementul Term cu "Num = 1") este conectat în poziţia corespunzătoare din 

schemă (similar şi portul 2). 

Nota2: Chiar dacă unele valori pot fi modificate direct pe schemă, se recomandă utilizarea interfeţei 

proprii pentru fiecare element pentru introducerea valorilor, interfaţă accesibilă prin dublu-click pe 

elementul respectiv. 

Urmează simularea efectivă în ADS:  sau F7 sau comanda din meniu Simulate > Simulate. 

Deoarece este o simulare de circuit, cu modele corespunzătoare dispozitivelor, vă puteţi aştepta ca 

simularea să dureze puţin, de ordinul secundelor. Fereastra simulatorului prezentată mai jos (fig. 24) 

rămâne deschisă. Urmăriţi mesajele pentru a identifica un eventual mesaj de eroare. Dacă e cazul, 

încercaţi să îl interpretaţi şi să corectaţi eroarea, în caz de insucces apelaţi la ajutorul cadrului 

didactic. 
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Fig. 24. Simulatorul ADS 

 
Fig. 25. Programul de vizualizare ADS 

După terminarea cu succes (!) a analizei se va deschide fereastra de vizualizare a rezultatelor (fig. 

25). Vă interesează să reprezentaţi parametrii S pentru rezultatele din EmPro şi pentru schema 

echivalentă, pe acelaşi grafic, deci veţi alege în momentul plasării graficului rectangular pe ecran 

S(1,1) şi reprezentarea modulului (în dB). Se compară reflexia la intrare, nivelul de metalizare M3, 

pentru ambele scheme (portul 1 pentru schema echivalentă, portul 3 pentru modelul emModel 

importat) deci S33/S11, şi transmisia între intrare şi ieşire (ieşirea e pe nivelul de metalizare M2, 

portul 2 pentru schema echivalentă, portul 4 pentru parametrii S importaţi) deci S43/S21 (fig. 26). 
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Fig. 26. Compararea simulării de circuit cu simularea electromagnetică pentru condensator PI 

 
Fig. 27. Compararea emModel/fişier cu parametri S 

Se menţionează în acest moment că utilizarea fişierului cu parametri S oferă exact aceleaşi valori. 

Comparaţia între cele două metode de a introduce datele din EmPro (fig. 27) oferă exact aceleaşi 

rezultate (în graficele din fig. 28 se introduce forţat o diferenţă de 1dB/0.1dB pentru a putea 

vizualiza ambele rezultate, în caz contrar graficele se suprapun exact). 

 
Fig. 28. Compararea emModel/fişier s2p (deplasare forţată a graficelor pentru vizualizare) 

Scopul analizei va fi determinarea valorilor de componente care să conducă la suprapunerea cât mai 

exactă a graficelor pentru model şi pentru simularea electromagnetică. Această metodă de generare a 

modelelor poate fi la modul general aplicată şi dacă setul de referinţă este obţinut în urma 

măsurătorilor şi nu din simulări electromagnetice. 
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Algoritmii de optimizare necesită: 

 indicarea elementelor care urmează a fi modificate,  

 alegerea unei metode de modificare/mod de calculare a abaterii faţă de ţintă, şi  

 indicarea obiectivului ce trebuie atins ("Goal")  

 
Fig. 29. Definirea variabilelor şi a intervalului de variaţie ADS > 2003 

Pentru a indica ce elemente trebuiesc modificate, se accesează interfaţa proprie fiecărui element 

(RLC - fig. 29 - butonul "Tune/Opt/...") şi apoi interfaţa de optimizare (tab "Optimization"), unde 

trebuie activat ("Enabled") respectiva componentă/valoare, urmat de limitarea intervalului de 

variaţie al componentei (posibilitatea variaţiei nelimitate - "Unconstrained" - deşi existentă în 

interfaţă, nu este recomandabilă într-un procedeu de optimizare). Ţinând cont de faptul că relaţiile 

de la curs oferă deja nişte valori estimate, se poate defini în jurul lor un interval (min/max) sau o 

abatere procentuală sau absolută în jurul valorii de start. Alegerea (fig. 29) a unui interval, are 

avantajul obţinerii unor limite cu valoare numerică "rotundă" uşor de remarcat în situaţia în care o 

componentă ajunge să atingă aceste valori în urma procesului de optimizare (situație care indică 

necesitatea schimbării intervalului). 

Se remarcă faptul că versiunile de ADS de după ADS 2009 beneficiază suplimentar de o variantă 

îmbunătăţită de a vizualiza şi modifica variabilele utilizate în procesele de optimizare, accesibilă din 

meniu Simulate > Simulation Variables Setup (fig. 30) 
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Fig. 30. Definirea variabilelor şi a intervalului de variaţie ADS > 2009 

După indicarea elementelor ce urmează a fi modificate, în schemă (fig. 20) acestea vor putea fi 

identificate ca fiind incluse în procesul de optimizare (valoarea elementului este urmată de {o}). Din 

paleta Optim/Stat/Yield/DOE (fig. 19) se introduce controler-ul de simulare corespunzător 

(OPTIM), care, împreună cu indicarea obiectivelor (GOAL) procesului de optimizare, va completa 

schema utilizată în procesul de optimizare (fig. 31). 

 
Fig. 31. Introducerea procedurii de optimizare 

Pentru controler-ul de optimizare trebuie indicate (fig. 32) metoda de optimizare utilizată (pentru 

problema curentă metodele Gradient sau Random sunt suficiente), variabilele şi obiectivele care se 

utilizează în algoritm şi numărul (maxim) de iteraţii care trebuie realizate pentru a ajunge la rezultat.  
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Fig. 32. Controlul procedurii de optimizare 

 
Fig. 33. Controlul obiectivelor 

În secţiunea "Parameters" se specifică care sunt datele care trebuie salvate (iniţiale, intermediare, 

finale), dacă programul de vizualizare asociat va fi activ în timpul simulării sau nu, dacă trebuie 

realizată o analiză cu valorile finale obţinute la optimizare. Activarea salvării unor date intermediare 

sau finale e necesară poate în etapa realizării proiectului pentru că permite urmărirea evoluţiei 

procesului (permiţând eventual oprirea a unei analize care nu se desfăşoară în direcţia necesară). 

Obiectivele pentru algoritmul de optimizare (pot fi oricât de multe, dar creşterea numărului acestora 

mai mult decât este necesar pentru rezolvarea problemei poate încetini sau chiar face imposibilă 

obţinerea unui punct optim) se introduc prin introducerea elementului "Goal" din aceeaşi paletă 

Optim/Stat/Yield/DOE (fig. 19). Elementul "Goal" (fig. 33) e caracterizat de o expresie matematică 

"Expression" şi una sau mai multe limite (<, >, =, Inside, Outside) care trebuie îndeplinite când 

variabila independentă "Sweep variable" (tipic această variabila este frecvenţa - "freq") variază între 
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valorile "freq min" şi "freq max". Pot fi mai multe variabile independente dacă problema de rezolvat 

o necesită. Orice element obiectiv şi orice limită au o pondere asociată "Weight" care poate fi 

utilizată pentru a forţa algoritmul să urmărească preferenţial îndeplinirea în special a anumitor 

obiective (de exemplu, în cazul de faţă mărimea de interes, capacitatea, se găseşte între porturile 1 şi 

2 ca urmare |S21| ar putea primi o pondere mai mare, de exemplu 100 - ţinând cont şi de faptul că 

valorile numerice pentru S21 sunt mai mici - fig. 28). 

Pentru a uşura modificarea simultană a tuturor obiectivelor se foloseşte un bloc VAR pentru a defini 

variabile pentru eroare modul (dmag), eroare fază (dphs), frecvenţă minimă (fmin), frecvenţă 

maximă (fmax). O schimbare în acest bloc va fi automat transferată la toate elementele obiectiv 

"Goal" care folosesc aceste variabile. Soluţia de optimizare obţinută este dependentă de cerinţele 

impuse şi poate apărea necesitatea de a forţa intervale diferite de variaţie a mărimilor independente, 

sau cerinţe diferite relativ la abateri. 

Pentru realizarea optimizării comanda este în meniu Simulate > Optimize sau utilizând butonul 

 din bară. În funcţie de opţiunea "Enable Optimization Cockpit" (fig. 32) se realizează procesul 

numai în simulator (fig. 24) sau folosind utilitarul "Optimization Cockpit" (fig. 34), varianta din 

urmă fiind recomandată pentru ADS 2016/2017 deoarece oferă posibilitatea vizualizării 

convergenţei sau nu spre o soluţie, oferă un punct centralizat din care se pot schimba toate 

obiectivele, metodele de optimizare, se pot adăuga paşi etc. 

 
Fig. 34. Utilitarul "Optimization Cockpit" 

Valorile obţinute în urma procesului de optimizare pot fi afişate (varianta recomandată este sub 

formă tabelară - fig. 35, anumite soluţii sunt disponibile în timpul procesului de optimizare, de 

exemplu OPTSOLNVARS, altele numai după finalizarea algoritmului de optimizare - OPTIM) şi 
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pot eventual fi preluate în schemă cu comanda Simulate > Update Optimization Values (comandă 

necesară doar dacă se utilizează mai departe aceste valori, în alte condiţii fiind preferabilă păstrarea 

valorilor iniţiale în schemă pentru realizarea unei scheme echivalente pentru un alt set de parametri 

S). Dacă se foloseşte utilitarul "Optimization Cockpit" se poate folosi butonul "Update design" sau 

la închiderea utilitarului se oferă opţiunea salvarii valorilor în schemă.  

 

 
Fig. 35. Valorile "în curs de optimizare"/"optimizate" din schema echivalentă pentru condensator PI 

Numărul de iteraţii parcurse poate furniza informaţii importante. Astfel, optimizarea cu metode de 

gradient caută un minim al obiectivelor pentru toată gama de frecvenţă, în mod normal la atingerea 

acestuia procedeul se opreşte. Încheierea cu succes a acestui algoritm se poate observa dacă numărul 

de iteraţii parcurs e mai mic decât cel indicat la pasul anterior (fig. 32). În caz contrar trebuie 

repetată simularea cu un număr mai mare de paşi, sau cu intervale mai largi pentru componente, sau 

cu abatere permisă mai mare. Dimpotrivă la optimizarea cu metode aleatorii (Random) se parcurg 

toţi paşii indicaţi, fără condiţii de oprire, deci numărul de iteraţii trebuie să fie egal cu cel maxim. 

Se realizează procedura de optimizare. În exemplul următor se utilizează metoda "Random" cu 100 

de iteraţii, urmată de "Gradient" cu 150 iteraţii (metodele de gradient depind de un punct de pornire 

aflat în apropierea soluţiei pentru a găsi minimul local al funcţiei, punct de pornire obţinut prin 

metode aleatorii). Obiectivele sunt realizate pentru o abatere ţintă a parametrilor S de 0.01dB 

(dmag = 0.01 în blocul VAR). Datorită valorilor numerice mai mici şi mai ales a prezenţei 

componentei ţintă (condensator PI) între cele două porturi, obiectivul corespunzător lui S21 va primi 

o pondere egală cu 10 şi o abatere ţintă mai mică (0.1*dmag). Valorile optimizate se preiau în 

schemă obţinându-se astfel modelul de circuit (fig. 36) care corespunde cel mai bine rezultatelor 

simulărilor (sau ale măsurătorilor, procedura de obţinere a modelului echivalent este aceeaşi dacă se 

realizează măsurători de componente). 

 
Fig. 36. Modelul final pentru condensatorul PI 

Fie prin realizarea unei analize de parametri S finale ("Final Analysis" - fig. 32) fie prin preluarea în 

schemă a valorilor optimizate şi realizarea manuală a unei analize de parametri S cu modelul 

echivalent al componentei simulate/măsurate, se poate verifica potrivirea între seturile de parametri 

S obţinute pentru model şi cele obţinute prin simulare/măsurători (fig. 37). 
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Fig. 37. Rezultatele optimizării pentru condensatorul PI 

Fiind vorba de numere complexe, coincidenţa trebuie verificată şi la nivelul argumentului 

parametrilor. Dacă se observă o diferenţă semnificativă la nivelul argumentelor este necesară o 

repetare a procedurii de optimizare, cu adăugarea unor obiective care să impună abateri maxime la 

nivelul argumentelor, de exemplu în schema din fig. 31 ar fi necesară utilizarea unor elemente 

"Goal" care să aibă expresia de forma: -1*dphs < phase(S(2,1))-phase(S(4,3)) < 1*dphs cu 

parametrul dphs în blocul VAR cu valori de ordinul unităţi sau zecimi (corespunzător unor abateri 

dorite de ordinul 1 grad, zecimi de grad). 

O ultimă procedură care poate fi efectuată constă în eliminarea din rezultat a liniilor de acces la 

armături, procedeu numit decapsulare ("de-embed" în engleză). În momentul de faţă structura 

simulată conţine efectul celor două linii de lăţime 40µm de acces la armături. Aceste linii nu pot fi 

eliminate din structura simulată deoarece ele întotdeauna vor exista în practică, ca urmare cuplajul 

între aceste linii, şi între fiecare linie şi armături este un fenomen pe care ne dorim să îl modelăm 

prin schema echivalentă. 

Realizarea decapsulării poate fi realizată în două moduri: 
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 în simulatorul electromagnetic, prin specificarea planelor de referinţă astfel încât să se 

elimine efectul liniilor (fig. 14-15) 

 în simulatorul de circuit prin introducerea liniilor în model 

În simulatorul electromagnetic EmPro procedura de specificare a planelor de referinţă există doar 

pentru metoda FEM de simulare, prin utilizarea porturilor de tip ghid de undă (fig. 38a.). 

"Waveguide Port" are în tab-ul "Properties" opţiunea "Reference Offset" cu care se poate specifica 

poziţia planului de referinţă. Pentru FDTD (şi pentru FEM) se pot utiliza porturile standard ("Feed") 

dar pot fi amplasate la nivelul armaturilor (fig. 38b), astfel liniile vor exista şi vor fi simulate dar 

parametrii S vor fi corespunzători doar componentei simulate. 

   
Fig. 38. Realizare decapsulare în EmPro 

Introducerea liniilor în simulatorul de circuit se poate baza pe folosirea utilitarului "Linecalc" Tools 

> Linecalc > Start Linecalc (fig. 39) şi obţinerea unor modele echivalente pentru linii, care să se 

introducă în schema echivalentă (fig. 40). Pentru liniile cu lăţimea de 40µm şi lungimea 

corespunzătoare se obţine (cu relaţiile/graficele din curs sau cu Linecalc) o impedanţă caracteristică 

de aproximativ 80Ω şi o lungime electrică de aproximativ 7° la 10GHz. 

 
Fig. 39. Utilitarul "Linecalc" 
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Fig. 40. Realizare decapsulare în ADS, linii ideale 

Dezavantajul utilizării liniilor ideale este că trebuie introduse în procesul de optimizare (ceea ce va 

duce la variaţia parametrilor de lungime/lăţime, lucru care nu se întâmplă în practică). De asemenea 

liniile ideale nu modelează dispersia liniilor microstrip, dispersie care îşi face simţită prezenţa în 

special la frecvenţe înalte, exact unde suprapunerea parametrilor din fig. 37 oferă mici diferenţe. Se 

preferă ca urmare utilizarea modelului de linie microstrip (fig. 41). 

 
Fig. 41. Realizare decapsulare în ADS, linii microstrip 

Comparând rezultatele obţinute prin optimizare (fig. 42) cu cele fără decapsulare (fig. 37) se poate 

observa o modelare mai bună la frecvenţe înalte, mai ales în cazul obţinerii defazajului introdus de 

circuit. La nivelul elementelor de circuit, efectul eliminării liniilor sunt vizibile mai ales în ceea ce 

priveşte valorile inductanţelor serie LM2 şi LM3 care sunt reduse în schema obţinută prin decapsulare 

ceea ce era de aşteptat, dimensiunile tipice ale liniilor (sute de µm) reprezentând lungimi electrice 

mici, de ordinul gradelor în tot intervalul de frecvenţă analizat. 

Schema din figura 41 oferă valorile componentelor din schema echivalentă a structurii analizate, 

după recuperarea ("Update Optimization Values") valorilor din algoritmul de optimizare. 
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Fig. 42. Rezultatele optimizării cu decapsulare pentru condensatorul PI 

Note finale 

 Ambele programe au nativ facilitatea de arhivare a proiectului File > Archive 

Project/Workspace. Arhivele EmPro trebuie realizate cu opţiunea păstrării rezultatelor 

("Archive simulation results") şi pot atinge dimensiuni destul de mari, pentru trimitere pe 

email fiind nevoie de obicei de apelarea la un serviciu extern de transfer fișiere (transfer.ro, 

wetransfer.com sau echivalent) 

 Termenul limită pentru predarea proiectului este ultima zi din semestru (13.01.2018). În 

cazul în care e posibilă extinderea acestui termen până la data examenului, acest lucru va fi 

anunţat prin email 

 Obţinerea unor rezultate valide în FDTD necesită celule de dimensiuni mici pe verticală în 

zona (şi numai în această zonă) straturilor de dielectric dintre cele două nivele de 

metalizare. Această secţionare generează o convergenţă mai dificilă, necesitând un număr 

mai mare de paşi pentru a obţine convergenţa (Setup FDTD Simulation > Specify 

Temination Criteria > Maximum Simulation Time >> 50,000 * timestep) 

 Utilizarea GPU cu tehnologie CUDA pentru FDTD poate aduce viteză semnificativ mai 

mare de calcul (o placă video "Gaming" medie poate creşte viteza de ~10 ori) 
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 EmPro are implementată nativ o facilitate de rulare automată, succesivă, a mai multor 

simulări. Acest lucru oferă posibilitatea de a folosi timpul în care calculatorul simulează un o 

versiune a proiectului pentru a modifica setările de convergenţă/secţionare şi a adăuga o 

nouă simulare la lista de execuţii ("Create & Queue Simulation"). Este recomandabil să se 

folosească această facilitate numai după ce s-a verificat rapid pe o versiune mai puţin "fină" 

a simulării că structura este corect introdusă şi se obţin rezultate corecte dpdv fizic 

(corespunzătoare tipului de componentă simulată). O astfel de procedură e utilă pentru 

parcurgere paşilor necesari (minim 3) pentru investigarea convergenţei în EmPro 

 Se reaminteşte că descrierea procedurii de convergenţă poate fi făcută numai într-un 

document suplimentar, proiectele EmPro/ADS nefiind suficiente. Un exemplu de prezentare 

justificare a convergenţei în EmPro şi ADS este cel din figura 43. Detalii suplimentare pe 

rf­opto.etti.tuiasi.ro > CIMM > secţiunea "Ani anteriori" > Proiect CIMM 2016 (alt soft 

utilizat dar principiul este similar) 

 Condiţia minimă pentru obţinerea notei 5 este ca dimensiunile structurii simulate în EmPro 

şi valorile iniţiale din schema ADS să corespundă temei individuale a fiecărui student 

(fiecare temă are alte dimensiuni fizice pentru componente)  

   
Fig. 43. Exemplu de prezentare a analizei de convergenţă în EmPro / ADS 

 

 


